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refl ect those of LIMac. 
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commercial use, with 
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Produced using: 
Tex-Edit Plus, Adobe 
InDesign, Photoshop, 
Illustrator and 
Acrobat.

The Internet SIG:  The Internet SIG meeting will be held at the Bethpage 
Public Library (516-735-4113) on Monday, October 16th at 8 p.m. 
SIGs immediately after the general meeting:
Beginners SIG: How to set up and use the Launcher and Aliases. (We will 
meet at about 7:45 and will end the same time as the main presentation.) 
Mac Help SIG: The indominatible Dichter/McAteer team update again!

DTP/Photoshop SIG: Show your 
good stuff from a fl oppy disk.
Business SIG: Make it your 
business to attend!
Mutimedia SIG: Making multi-track 
QuickTime movies in Premiere.
x LIMac meetings, unless otherwise 
noted, are held in Building 300 
(Anna Rubin Hall) at the New York 
Institute of Technol ogy on Northern 
Blvd. in Old Westbury. 
| In bad weather, call 516-686-7789.
| The next LIMac board meeting 
will be at the Plainedge Library 
(516-931-3907) on Wednesday, 

Scott Travers gave an engaging demonstration 
of the new Microsoft Office:Mac 2001.

Scott spent most of his time highlighting 
the new member of the Office suite – Entour- 
age 2001, the new address book, calendar and 
task manager. Very cool how you can link 
e-mail and Web pages to contacts and bring 
up a Web-based map to any address. The usual 
alerts are there, and you can easily convert 
from Now Up-To-Date/Contact or Personal 
Organizer. Your old favorites from MS Office 
have been enhanced to be more Mac-like 
and take better advantage of Mac OS func-
tions. The AppleWorks-inspired Project Gallery 
offers task-oriented choices for you to be 
led to content creation. The context-sensitive 
Formatting Palette makes better use of 
screen real estate with collapsible sections. 
PowerPoint now uses QuickTime effects and 
can save a presentation in QuickTime format. 
Excel’s list or database prowess has been 
improved to make common tasks chi ld’s 
play. There is the new Data Merge Manager 
for easy mail or e-mail merge, going beyond 
the new linked Contacts Toolbar available 
from Word 2001. Office 2001 Macintosh 
edition comes in a case that you can use to 
store other CDs. There is no printed manual, 
just a big Adobe Acrobat file. You should 
be able to upgrade by October 11. Scot 
didn’t have the upgrade pricing, but the 
mail order catalogs seem to be asking $270. 
If you bought Office’98 or any Office ’98 
element after July 18, you’re entitled to a 
nearly-free upgrade to 2001. You just have to 
pay $7.50 shipping and sales tax. Coupon at 
http://www.microsoft.com/mac/products/office/
2001/techguarantee/coupon.pdf.

System requirements: A Power Mac run-
ning Mac OS 8.1 – Mac OS 8.5 or newer is rec-
ommended. At least a 120MHz processor and 
a minimum of 32MB of RAM and 160MB Hard 
Drive space. Figure more RAM and plenty of 
disk space for typical users. All in all, it was an 
interesting, informative presentation. 

Thanks, Microsoft! 0
–BradleyDichter/Scott Randell

We’ll show you 
how to create 
superior quality 
enlargements 
with Altamira’s 
PrintPro and 
Genuine Fractals 

2.0, the award-winning image scaling plug-ins 
for Photo  shop, PhotoDeluxe, Photo-Paint 9 and 
Paint Shop Pro 5.03/6.1.

Altamira’s Scaling Technology enhances 
scaling capabilities within Photoshop and 
compatibles. It allows users to capture, work 
in, e-mail, and store small files then repurpose 
as needed; it eliminates re-scanning and 
storing several copies of an image for multiple 
uses; and it enables enlarging, reducing, 
cropping and scaling images – all without 
degrading the original image quality.

Altamira PrintPro – Essential for graphic 
designers, prepress houses, printers and those 
who may need to work in CMYK and CIE-Lab 
in addition to RGB, grayscale, indexed color, 
duotone and multichannel color modes.

Altamira Genuine Fractals 2.0 – Perfect 
for digital or film-based photographers, digital 
designers, users of inkjet and large-format 
printers or anyone who utilizes only RGB, 
grayscale, indexed color, duotone and multi-
channel color modes. 0
Friday, October 13th, 7:00 p.m. The New York
Institute of Technology, Old Westbury.
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Technical CornerPresident’s Message

Bradley Dichter
bdichter@cdr.net

Bill Medlow
President
ArchBill@aol.com

| Will installing Norton Utilities 5.0 over-
write version 4.0?
No. You should first delete the Norton 
Utilities folder and the Preferences and 
the Norton FileSaver and Norton FileSaver 
Assistant before installing the version 5. 
Afterwards, delete the DiskLight Control 
Panel – it’s more trouble than it’s worth. Also, 
allocate 24K more memory to the Norton 
FileSaver Assistant. Very few totally new ver-
sions of any software replace the previous 
full release; only most updaters to new sub-
versions replace the old. All too often, the 
preferences for a previous release will cause 
problems for the current release. One of the 
good reasons to hang onto installer logs is to 
find out what to throw out when updating.
| I’ve signed up with Optimum Online, but 
the home page is theirs. How do I change 
it? I’m using Netscape Communicator.
Go to the Edit menu, select Preferences..., 
the window should appear with the correct 
category showing. (It’s the Navigator cate-
gory.) You can type in a preferred URL here, 
or if the currently showing Web page is your 
preferred home page, you can just click the 
Use Current Page button. We suggest using 
http://www2.limac.org/limac/index.html.
| I have a System 7.5.1 Performa 6205 with 
40MB of RAM. If I upgrade to Mac OS 8.1, 
will I loose any applications?
Probably, yes. The programs themselves will 
still be there, but they may no longer work. 
Perhaps more importantly, your Mac may no 
longer startup without crashing because of 
the Extensions and Control Panels besides the 
Apple operating system that needs upgrading 
or removal to work with Mac OS 8.1. You 
should obtain upgrades to all of these before 
upgrading the operating system. Some items 
have been discontinued, so you’ll have to 
either do without, or find substitutes. This 
warning applies to the extras that Apple 
included as well as anything else you may have 
added. At least your Express Modem should 
still work under OS 8.1. It wouldn’t under OS 
8.5 or newer. Have you considered selling the 
Performa and buying an iMac instead?
| Is there an easy way to send a picture 
from a non-AOL user to an AOL user?
Save the picture as a JPEG format file (RGB 

Book Review
Adobe PhotoShop 5.5 Classroom 
in a Book.
552 pages with a CD-ROM.
Peachpit Press 1999
ISBN 0-201-65895-X
$45
Reviewed by Helen and Sheldon Gross
The original Macintosh computer, circa 1980, 
was advertised as a computer that would let 
you be an artist with no real ability. Of course, 
if you had an artist’s eye you would be able 
do spectacular things. Adobe’s latest text and 
tutorial for PhotoShop 5.5 and ImageReady, 
Adobe PhotoShop Classroom in a Book, is 
an excellent tutorial. It will definitely enhance 
your own capabilities.

 We found it necessary to spend consider-
ably more time than the text suggests, but 
keeping at it made it possible to produce some 
wonderful things. Suggestions appear in the 
middle of a project and the lessons need not 
all be done to the same degree of perfection. 
In fact, we found some much more difficult 
to accomplish. It is important to try them, 
however, and at least get to understand the 
vocabulary of each lesson, before going on to 
the next one.

The text covers the production of both 
print and Web documents, with clearer expla-
nations than we have seen anywhere else. 

This book (and its CD) goes much further 
than we were able to go, but nevertheless, it 
seems to be a worthwhile addition to any Mac 
users library – and something to keep one out 
of trouble for quite a while! 0

Graphic Converter:
A Review
Out of all the shareware utilities for 
graphics, Graphic Converter reigns 

at the top. Developed by Lemke Software Graphic 
Converter does what it says, and converts graphic 
formats from one file type another. You can also 
edit graphic files in the program using the pro-
vided tool palette. You can also add many affects 

such as distiller by using the Effect menu.
In my opinion, the most important feature 

of Graphic Converter is batch conversions. As 
a Web-master, I really depend on this feature. 
To use this feature, you go to the File menu 
and choose Convert More, and select a group 
of files to convert. After the conversion starts, 
you just sit back and relax while the software 
does all the work for you.

Graphic Converter may not be nearly as 
powerful as Adobe PhotoShop, but with fea-
tures such as filters and the support for 
plug-ins, Graphic Converter really holds its 
own. Graphic Converter also lets you get a lot 
done with less then half the RAM of its Adobe 
counterpart. If you’re just getting started in 
the world of graphics, and don’t want to spend 
$300 on PhotoShop get a copy of Graphic 

Converter.
Download & Registration Info;

Graphic Converter sells for $30, and 
can be downloaded at : http://lemkesoft.de/
us_gcdownload.html 

You can purchase this program via the 
built- in shopping cart.

–Mac OS Planet 

Data Recovery 
with Data Rescue :
A friend of mine, ini-
tialized one of her 
volumes by mistake.                                      
I tried to restore 
the files using Norton 
Utilities 5.0 without 
any success. A mem-
ber of the Montreal’s 
Macintosh User 
Group suggested to 
me that I look for 
something called 
Data Rescue – it did 
the job. It was able 
to reconstruct the 
Catalog and I had to 
specify the Allocation 
Block size in order to 
get the files back.

This shareware 
is not expensive 
[$39] and can save 
a lot of time. It is a 
must in any toolbox.

–Dennis Mailloux

It’s Fall Cleanup Time!
Do you remember how fast you thought 

your Mac was when you purchased it – or how 
fast it booted up? Over the last few months 
Bradley has been showing us how to clean the 
System Folder as well as the whole Hard Drive 
to make your Mac as fast as it was when new.

It’s time for you to do the same thing. Put 
your Mac on a diet and breathe some of the 
old life back into it.

For those with new Mac’s, think twice 
before adding any unnecessary items. 0

Elements of Design:
Two Is Not Better 
Than One!
Repeat after 
me…“One space after 
a period. One space 
after a period.” Got it?

The Mac is not a 
typewriter. With few 
exceptions, fonts on 
a computer are pro- 
portional fonts, 
meaning that an “I” 
takes less physical 
room than an “m.” 
The space you type 
when you hit the 
Spacebar is preset 
to leave the correct 
amount of space 
between sentences 
for that particular 
font. Two spaces 
leaves too much, 
forcing the eye to 
jump to the start 
of the next sentence, 
and actually slows 
down reading.

If you just can’t 
get over the two- 
space habit, do a 
global search on the 
document and 
replace all double 
spaces with single 
spaces.

You have my 
permission to beat 
every keyboarding 
teacher over the 
head with this 
article.

–Kathleen Innes

 STUFF!

  TIP!

http://lemkesoft.de/us_gcdownload.html
http://lemkesoft.de/us_gcdownload.html


A Word to the Wise:
A friend of mine initialized one of her volumes 
by mistake. She has a G4 and her 20GB is split 
in three volumes. Thinking she had selected the 
icon of a diskette, she choose (under the Finder) 
the item Special: Erase disk…, but, in fact, it 
was a volume of 9GB that had been selected and 
therefore initialized!!

I tried to restore the files using Norton 
Utilities 5.0 without any success. A member of 

the Montreal Macintosh User Group suggested 
to me that I  look for something called Data 
Recover. I found Data Rescue (probably the 
same product he had in mind) and it did the 
job. It was able to reconstruct the catalog and 
I just had to specify the allocation block size in 
order to get the files back.

This shareware is not expensive [$39] and 
can save a lot of time – a must in any toolbox.

–Dennis Mailloux

Apple drops support for original Power Macs? A 
source informs us that, as of July 1, Apple is no 
longer selling parts for, nor otherwise supporting 
,the Performa 630 and the first generation Power 
Macs (6100/7100/8100/8150/9150 models).

Be careful when unwrapping an iMac! 
An Apple technician informs us that slot-
loading iMacs come wrapped in a bag that 
has been sealed with an adhesive label 

which displays some text about software usage 
agreement, etc. Be careful, don’t let this label 
come in contact with the iMac as you unwrap it. 
The adhesive leaves a residue that doesn’t come 
off and can ruin the plastic finish of the case.

Here’s one from Bradley: “The icon for the 
Classic application that you run under Mac 
OS X to be able to run carbonized Mac OS 9 
applications. Better get used to it.”

More Technical Corner 3
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 TIPS!

mode, 72 dpi) and send that as an attach-
ment to your e-mail. Do not try to include 
it in the body of the e-mail. The trick is the 
encoding method. Using Outlook Express, If 
you Binhex encode, the picture will come 
in looking like gibberish text, preceded by 
the notice this must be decoded with Binhex 
4. You can save this e-mail and drag and 
drop it onto StuffIt Expander to decode. 
Alternately, you can encode with AppleSingle. 
The picture will be recognized as an 
attachment. You can then click Download 
Now, save the file and a preview window 
will appear with the 
picture. Using Communicator, the default 
MIME encode works fine, like the 
AppleSingle from Outlook Express but the orig-
inal file name is preserved.
| I have a Casio QV-780 digital camera 
that I use with the video in card on my 
Performa 6500. Can I use this camera 
with a digital port?
The camera stores it’s 640x480 pictures on 
a Compact flash card as well as the so 
called Digital In/Out port. You can read the 
images with the supplied software (QV-Link) 
in TIFF, PICT or JPEG format. The camera 
also works through Adobe PhotoDeluxe and 
QV Plug-in 3.1. You just use the SB155 QV to 
PC communications cable with the Mini-Din 
8 adapter into your Mac Printer port. You 
may have to turn off AppleTalk to use your 
Printer port. (The Modem port is capped) 
Otherwise you can use a SCSI CompactFlash 
card reader to read the little cards you put 
in the camera. The camera supports up to 
64MB cards. Seven Fine quality images per 
megabyte.
| I just bought a new iMac DV (indigo). 
If I extend my warranty with an 
AppleCare contract, do I still have to pay 
a service provider and pass on my con-
tract number?
No. If you pay for a service contract, you just 
need to advice the service provider of your 
contract number. They will confirm with 
Apple and not bill you for covered repairs 
for the duration of the contract. Now if you 
damage the computer by not taking proper 
care of it (say you dropped it onto a con-
crete floor), you’ll have violated the contract 

and then you will have to pay for repairs. 
Also, if you don’t give the service provider the 
AppleCare contract number, they will want 
to bill you, since they didn’t know to check 
if this iMac was covered by an extended con-
tract. If you bring it in for repair during the 
first year, bring your dated sales receipt, so 
they will know it’s covered by the standard 
one year repair period. As for tech support, 
the standard free 90-day period does not start 
the day you buy the Mac. It starts when you 
first call with a problem. They will give you a 
tech support case number that you can refer 
to for the rest of the 90 days. If you have two 
independent tech support questions during 
the 90-day period, refer to the case number 
given you. One hardware related problem that 
you may cause yourself is the new slot loading 
drive cannot handle the business card sized 
CD-ROM discs you may see. I see them in 
CompUSA at the register as PokeROM and 
many vendors sell recordable disks and label-
ling kits for these discs. The eject mechanism 
cannot engage these discs and they become 
lodged in your CD- or DVD-ROM drive. The 
small 120mm round CD-ROM discs are OK, 
but the squared-off version is trouble.
| Can you talk about powered versus 
un-powered USB hubs?
You almost always want a powered hub. That 
is one that comes with a little AC adapter. The 
powered hub supplies power to connected 
USB devices rather than letting them draw 
power from the USB port on the Mac’s moth-
erboard. This almost always causes many prob-
lems as most devices draw too much for the 
Apple design. Keep the keyboard and mouse 
on port two and use a powered hub on port 
one with everything else plugged in there. 
Some new monitors have USB hubs within 
them. The only time you might use a non-
powered hub, is with a laptop. There are 
a couple of mini-hubs out there that are 
non-powered for smallest size and weight.  
Sometimes it’s best to have the hub’s input 
USB cable unplugged during startup to avoid 
problems. Plug it back in when the Finder 
loads. Various USB related problems require a 
System Software or Firmware update to resolve. 
Mac OS 9 users can use the Software Update 
Control Panel. 0 

 TIP!

Elements of Design:
Two Is Not Better 
Than One!
Repeat after 
me…“One space after 
a period. One space 
after a period. One 
space after a period.” 
Got it?

The Mac is not a 
typewriter. With few 
exceptions, fonts on 
a computer are 
proportional fonts, 
meaning that an “I” 
takes less physical 
room than an “m.” 
The space you type 
when you hit the 
Spacebar is preset 
to leave the correct 
amount of space 
between 
sentences for that 
particular font. Two 
spaces leaves too 
much, forcing the 
eye to jump to the 
start of the next sen-
tence, and actually 
slows down reading.

If you just can’t 
get over the 
two-space habit, do 
a global search on 
the document when 
you’re 
fi nished and replace 
all double spaces 
with single spaces.

And yes, you 
have my permission 
to beat every key-
boarding teacher 
over the head with 
this article.

–Kathleen Innes

Apple made an 
announcement that is 
sure to make more 
than a few Mac users 
happy. That announce –
ment was that they 
have added renowned 
Macintosh author 
David Pogue to the 
growing list of 
features to the Apple 
site. According to the 
Apple press release 
Pogue will be working 
in the Macintosh prod-
ucts guide section on 
the Apple web site. For 
the time being David 
will be posting a guide 
called Mastering Your 
Macintosh that will 
teach Mac users how 
to, well maximize their 
Macintosh. Some of 
the guides that Mr. 
Pogue is said to pub-
lish are: Getting the 
most from Sherlock 
2; Getting the most 
from iMovie ; Getting 
the most from the 
Mac OS; Getting the 
most from 
AppleWorks ; 

The Sherlock2 
guide did a great 
job of explaining the 
best and easiest 
ways to use the 
Sherlock program in 
a way in which both 
new and advanced 
users should find 
both enjoyable and 
educational. You 
can read the first 
and future install-
ments of Apple’s 
new Maximizing Your 
Mac feature at 
guide.apple.com/poguejune1.html.



Helen and
Sheldon Gross
shel9 @ bellatlantic.net

Sore Eyes

Note: These sites are 
referred to by us for 
your information only 
and neither we nor 
LIMac endorse any of 
the products or sites.
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Max Rechtman
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We’ll show you how 
to create superior 
quality enlargements 
with Altamira 
PrintPro and 
Genuine Fractals 2.0, 
the award-winning 

image scaling plug-ins for Photo  shop, 
PhotoDeluxe, Photo-Paint 9 and Paint Shop Pro 
5.03/6.1.
Friday, October 13th, 7:00 p.m. The New York 
Institute of Technology, Old Westbury.

This month our featured presentation will 
be from the Altimira Group, makers of 
Genuine Fractals and Genuine Fractals Print 
Pro. These products are resolution enhance-
ment Photoshop plug-ins. Altimira was one 
of the vendors that sponsored the Apple 
User Group University Conference, which 
met during the week of the MACWORLD EXPO. 
We wish to thank Altimira for its generous 
support of User Groups. 

As a result of the User Group University 
Conference we are able to line up exciting pre-
senters for our group and to offer great raffle 
prizes that are donated by many generous 
vendors.

We would like to start a Palm/Handspring 
SIG that will meet once every few months 
after the general meeting. We intend to 
look at the Palm software that is currently 
available and discuss the integration of the 
Palm with the Macintosh. If you are inter-
ested in participating, please e-mail either Rick 
Matteson at rickgm@earthlink.com or myself 
at maxlimac@aol.com. 
Mac User Group Store information: 
Remember, every time a user group member 
makes a purchase, our user group gets a point, 
worth one percent of any purchases. These 
points are redeemable toward anything the 
Mac User Group Store sells. 0    
http://www.applemugstore.com/
User ID: osx
Password: aqua

I know that I promised a column on varied 
search engines this month, but it will have to 
be delayed. I found that what I wanted to say 
required additional research and this research 
had to take a back seat to the research on the 
G4 Cube, we are in the process of buying. 

We fell in love with the Cube at 
MACWORLD this past summer and we have 
to research it more fully to justify the expense.

First, we got rid of all our older Macs, 
leaving us with only the original Beige G3 
Desktop computer and the iBook, that Shelly 
barely lets me look at. We accomplished this 
by giving assorted items to our grandchildren 
and children, who were delighted to have 
them. The Lucent PC Airport card that I 
purchased for my older 1400 Laptop (which 
started life as a regular 1400 but has been 
upgraded to a G3 System) has now been 
removed from the 1400 and has a new 
lease-on-life on my son’s G4 Laptop. He is 
delighted because he says he was not prepared 
to spend that much for his office machine. 
The 1400 went to Willow, my 16-year-old in 
Virginia. She had been using an old Performa 
638CD and now has a PowerPC.

All this to get to the Cube. The G4 Cube 
comes with 64 Megabytes of RAM and a 20 
Gigabyte hard drive. We plan to add addi-
tional memory, but keep the 20 Gigs/450 
Megahertz version as is. We’d rather spend the 
extra money on the lovely looking flat screen, 
(although not the $4000 one). There have 
been reports of problems with the plastic case 
but we are not too sure about the seriousness 
of this. We plan to take out Apple Care as we 
have done with the iBook, so let them worry 
about it. We’re just about to go ahead. Next 
month, I promise to research search engines.0

Duplicate text with 
the Option key:
A speedy alternative 
to using Cut-and-Paste 
commands to dupli-
cate highlighted text 
(if the application you 
are using doesn’t sup-
port Drag-and-Drop): 
Just press the Option 
key while dragging the 
selection. The dupli-
cate appears wherever 
you release the 
mouse.

 TIP!

http://www.limac.org
http://www.applemugstore.com/

